
Tek UWB
Spectral Analysis
Printed Help Document

www.tektronix.com
077-0033-02



Copyright © Tektronix. All rights reserved. Licensed software products are owned by Tektronix or its
subsidiaries or suppliers, and are protected by national copyright laws and international treaty provisions.

Tektronix products are covered by U.S. and foreign patents, issued and pending. Information in this
publication supersedes that in all previously published material. Specifications and price change privileges
reserved.

TEKTRONIX and TEK are registered trademarks of Tektronix, Inc.

Tek UWB Spectral Analysis Online Help Version 2.2.0, part number 076-0085-02.

Contacting Tektronix
Tektronix, Inc.
14200 SW Karl Braun Drive
P.O. Box 500
Beaverton, OR 97077
USA

For product information, sales, service, and technical support:
In North America, call 1-800-833-9200.
Worldwide, visit www.tektronix.com to find contacts in your area.

http://www.tektronix.com/contact


Table of Contents

Table of Contents

Preface
Conventions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
Updates through the Web Site. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

Getting Started
Introduction and Product Description . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
Compatibility. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
Requirements and Restrictions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4
Limitations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4
Starting the Software

Starting the Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
Returning to the TekScope Application .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
Returning to the Software. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
Exiting the Software. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

Operating Basics
Software View

Application Data Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
Configuring the Tek UWB

Selecting the Analysis Type . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
Selecting a Waveform for Analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
Analyzing Waveform Files in Batch Mode .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
Selecting the Pulse/Packet . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15
Setting the Resolution Bandwidth .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
Setting the Center Frequency.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
Setting the Span. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
Saving the Downconverted Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
Setting the Band Group .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
Setting the Time Frequency Codes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22
Setting the Data Rate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
Setting the Preamble Type . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
Setting the Payload Length .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25

Analyzing the Waveform
Analyzing the Waveform .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25

Viewing Plots
Voltage Versus Time.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
Spectrogram .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28
Power Spectral Density . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30

Tek UWB Spectral Analysis Printed Help Document i



Table of Contents

Constellation .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
EVM Versus Symbol . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
EVM Versus Subcarrier . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
Using Plot Cursors. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
Using Plot Zoom.. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36

Viewing Modulation Results History
Listing Window Data. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
Saving the Results in .csv Format. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
Generating and Saving Reports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38
Clearing All the Results . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

Tutorial
Capturing Live WiMedia RF .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41

Index

ii Tek UWB Spectral Analysis Printed Help Document



Preface Conventions

Preface

Conventions
The online help uses the following conventions:

When steps require a sequence of selections using the software interface, the ">" delimiter marks each
transition between a menu and an option. For example, File > Save.

DUT refers to the Device Under Test.

Three dots (...) following a menu item indicate that the menu item will open a submenu.

Updates through the Web Site
Periodic software upgrades may be available.

To check for upgrades:

1. Go to the Tektronix Web site (www.tektronix.com/software) to link to the Software Downloads page.

2. Enter the product name Tek UWB in the Search by keyword box to find the available software upgrades.
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Getting Started Introduction and Product Description

Getting Started

Introduction and Product Description
Excellent amplitude, phase flatness, and low phase noise make the DPO/DSA70000 series oscilloscopes
the ideal tool for engineers designing Ultra Wideband radios used in Certified Wireless USB, Wideband
Bluetooth, WiNet, and DNLA consumer and computer systems.

Tek UWB runs on the TDS series oscilloscopes with single shot bandwidth ≥7 GHz and DPO/DSA
series oscilloscopes with single shot bandwidth ≥2.5 GHz.

Tek UWB analyzes the complexity of wideband signals that change in frequency and amplitude with
time. It measures the distribution of signal power with frequency and analyzes specific signals in the
presence of other traffic with time gating and packet/pulse finder within upto 200 Mpt record lengths.

Quickly generates Power Spectral Density and Spectrogram plots from acquired data.

Correlates the Frequency domain to Time domain with cursors linking the amplitude versus time,
frequency versus time, and power versus frequency.

The Downconvert option allows for rapid generation of baseband data for further analysis in other
tools such as Tektronix RSA Vu and MATLAB.

The WiMedia PHY Test option automatically detects all 10 Time Frequency Codes and eight data rates
directly from the WiMedia RF waveforms for easy setup and analysis.

Covers the digital down-conversion, demodulation, and analysis of all six WiMedia band groups.

Generates plots of EVM-vs-Symbol, EVM-vs-Subcarrier, and Constellation data.

Performs measurements outlined in the WiMedia PHY Test Spec 1.2 including EVM, cross correlation,
frequency tolerance, adjacent channel power ratio, spectral mask testing, and relative power ratios.

Report generator quickly documents the configuration information, measurement results, and plot
images.

Compatibility
For information on instrument compatibility, refer to the Optional Applications Software on
Windows-Based Oscilloscopes Installation Manual (Tektronix part number 077-0067-XX) available
as a PDF on the DVD.
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Getting Started Requirements and Restrictions

Requirements and Restrictions
The following are recommended for running Tek UWB:

TDS series oscilloscopes with single shot bandwidth ≥7 GHz and DPO/DSA oscilloscopes with single
shot bandwidth ≥2.5 GHz.

Oscilloscopes with single shot bandwidth of 7 GHz or greater for WiMedia signals in band group 1.
Analysis of higher band groups requires oscilloscopes with correspondingly higher bandwidths.
Coverage for all six WiMedia band groups will require a single shot bandwidth of at least 14 GHz.

Analysis of radar signals through X band and Ku band calls for real-time bandwidth beyond 16 GHz.
The DSA72004 oscilloscope with single shot bandwidth of 20 GHz and deep 200 Mpts record length
provides the greatest flexibility for analyzing such high speed signals.

Limitations
Proper analysis of WiMedia signals generally requires an acquisition sample rate of 20 GS/s or higher and
record lengths of 1 Mpts or more. This application will not even attempt WiMedia analysis unless the
sample rate is at least 250 MS/s with a record length of 100 Kpts or more.

When using Tek UWB with very long captured waveforms (generally over 100 Mpts), it is possible
for the application to run out of available memory with the operating system. This condition depends
on the number of other applications running, the length of the waveform being analyzed, and the type
of analysis that is being performed. If an out of memory error message is encountered, we recommend
using the time gating feature of the oscilloscope to reduce the amount of data being analyzed. To do
this, place the instrument cursors around the part of the captured waveform you want to analyze before
beginning an analysis with Tek UWB.
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Starting the Software

Starting the Software
Depending on the type of oscilloscope that you have, you can start the software in one of the following
ways:

Select App > Ultra Wideband Spectral Analysis

Select Analyze > Ultra Wideband Spectral Analysis

The following screen indicates that the software is loading.

NOTE. Without a product license installed, Tek UWB allows five free trial sessions, after which the
application will operate in a restricted mode until a valid license is provided.
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Getting Started Returning to the TekScope Application

The oscilloscope displays the Tek UWB Ultra Wideband Spectral Analysis software with the analysis
type set to Spectral Only.

Returning to the TekScope Application
To return to the oscilloscope application from the Ultra Wideband application, click the TekScope icon
(near the lower right corner).

TekScope icon

Returning to the Software
To return to the Ultra Wideband application, select Restore Application in the Analyze or Application
menu.
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Getting Started Exiting the Software

Exiting the Software

To exit the software, click on the top-right of the software window.
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Operating Basics
Software View

Application Data Files
The software uses the following data files:

File name extension Directory Description
.wfm C:\Program Files\TekApplica-

tions\TekUWB\Waveforms\
To store the sample waveforms.

xxx

Configuring the Tek UWB

Selecting the Analysis Type
To set the analysis type for debugging radios, click the Config tab.

Config tab

Then select one of the available options in the Analysis Type: pane.

Analysis Type

Spectral Only (default): acquires and displays the Voltage versus Time. It calculates and displays
the power spectral density (PSD). In addition, it displays the PSD data as a spectrogram, showing the
harmonic content of the signal as a function of time. The resolution bandwidth used in these calculations
is user-definable.

Spectral + Downconversion: performs the same basic analysis as the Spectral Only option. In
addition, it performs a digital down-conversion step which allows you to create baseband data for further
analysis in other tools such as Tektronix RSA Vu and MATLAB.

WiMedia PHY Test Specification 1.2: performs the same basic analysis as the Spectral Only
option. In addition, it performs a full modulation analysis according to the WiMedia PHY test specification
and displays three additional plots Constellation, EVM versus Symbol, and EVM versus Subcarrier.
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Operating Basics Selecting the Analysis Type

WiMedia Analysis
Consider the following information when performing WiMedia analysis:

You should select the appropriate band group for the signal being studied by selecting a Band Group
button on the Config tab.

This application can auto-detect the TFC of the signal. However, if problems are encountered during
demodulation, you can override auto-detection by selecting the appropriate TFC in the TFC section
of the user interface.

This application can auto-detect the data rate. However, if problems are encountered during
demodulation, you can override auto-detection by selecting the appropriate data rate in the Data Rate
section of the user interface.

This application can auto-detect the preamble type. However, if problems are encountered during
demodulation, you can override auto-detection by selecting standard or burst.

Payload Analysis can be set to 96 symbols as mentioned in the WiMedia test specification or All
symbols.

The application displays and reports the following information:

A Power Spectral Density analysis separated by band with ACPR, mask test, and power measurements.

A Constellation plot and EVM analysis.

A plot of EVM by symbol.

A plot of EVM by subcarrier.

An Information box (containing date, instrument setting, and similar data) includes additional
information on modulation.

A Results History.

A report of the Modulation Analysis including the plots.

Packet Detection and Selection
This application features a packet detector, which scans the waveform and tries to identify the presence
of a finite-duration signal. When multiple packets have been identified, you can select which packet to
analyze using the Packet Selection buttons on the display:

1st, analyze first packet only

2nd, analyze second packet only

3rd, analyze third packet only

4th, analyze forth packet only

All, analyze all packets in succession (100 maximum)

Off, analyze the entire waveform ignoring packets
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Operating Basics Selecting a Waveform for Analysis

WiMedia Terminology

Band numbering. There are 14 bands (each 528 MHz wide) spanning the 3100 MHz to 10600 MHz
UWB spectrum.

Band groups. There are six band groups within the UWB spectrum. Band groups 1 to 5, each consisting
of three 528 MHz bands (except band group 5 which has only two bands) lie in sequence across the UWB
spectrum. Band group 6 also consists of three 528 MHz bands, but it straddles the frequency space of
band groups 3 and 4.

Time Frequency Codes (TFC). There are 10 hopping patterns (TFCs) defined in the WiMedia standard.
Four patterns spread the coded information across three bands (Time-Frequency Interleaving or TFI).
Three patterns spread the coded information across two bands (TFI2). The remaining three patterns
transmit the coded information on a single band (Fixed Frequency Interleaving or FFI).

Common Phase Error (CPE). In the EVM calculation, CPE of the transmitter is corrected on a
symbol-by-symbol basis.

CPE filtering. CPE filtering analysis allows the EVM calculation to see the transmitter phase noise
impairments.

Error Voltage Measurement (EVM) calculation. EVM is calculated over the payload of the packet only. The
calculation includes initial channel estimation using the CE symbols, phase and timing estimation, and
correction using the pilot tones as well as estimating the frequency offset. The phase error is estimated
using pilot tones and the timing error, and common phase error is calculated. Timing error is corrected.
The CPE is applied to the CPE filter. For each data and pilot subcarrier, the Euclidean distance to the
closest constellation point is calculated. The RMS error is calculated using the WiMedia equation.

Selecting a Waveform for Analysis
To select the source of the measurement, click the Config tab.

Config tab
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Operating Basics Selecting a Waveform for Analysis

You can select the waveform source in the following ways:

Input source Selections Description Default
Ch

Channel
In the Config tab, click the "Ch" tab to
display the Channel pane.

Tek UWB acquires live signals from the
channel selected.

Click Setup

Setup
Channel Setup sets the selected channel
in the oscilloscope to a default setup for
Wideband RF.
The settings are reported on a pop-up
window as follows and can be modified
using the oscilloscope controls.

1, 2, 3, and 4 Selects one of the
four live channels
as the source for
acquisition.

1
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Operating Basics Selecting a Waveform for Analysis

Input source Selections Description Default
Math

Math
In the Config tab, click the “Math” tab to
display the Math pane.

Tek UWB acquires the Math waveform
from the oscilloscope.

1, 2, 3, and 4 Selects one of
the four math
waveforms as
the source for
acquisition.

1

Ref

Reference
In the Config tab, click the "Ref" tab to
display the Reference pane.

Tek UWB acquires the reference
waveforms from the oscilloscope.

1, 2, 3, and 4 Selects one of the
four reference
waveforms as
the source for
acquisition.

1

File

WFM File
In the Config tab, click the "File" tab to
display the WFM File pane.

Select allows you to choose a .wfm file
to be analyzed.
Click Select to open the "Select File(s) to
Load" window.
Select one file or multiple files by using the
Shift or Ctrl key with a mouse click.

Select Selects one or
multiple files as
the source of the
acquisition.

N/A

xxx
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Analyzing Waveform Files in Batch Mode
WiMedia radios operate at multiple data rates, time frequency codes, band groups, and power levels. You
might need to capture 50 or more waveforms to thoroughly test your device. It may be more convenient to
capture and save the waveforms in rapid succession and then analyze all the waveforms as a batch process.

1. In the Config tab, click File.

2. Click Select to open the "Select File(s) to Load" window.

Window

3. Select a file or multiple files by using the Shift or Ctrl key with a mouse click.

4. Click Test All to sequence through and process all the selected waveforms without stopping. Tek UWB
will analyze all waveforms, and will return Analysis successful as the status. Click Test File to process
the next file in the list and then halt. This allows files to be processed one at a time, but without the
need to reopen the file selection dialog box every time.
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Operating Basics Selecting the Pulse/Packet

5. To see the result summarized for the sequence of waveforms, click the Reports tab.

Selecting the Pulse/Packet
This application features a pulse/packet detector which scans the waveform and tries to identify the
presence of a finite-duration signal within the captured data. When pulses are detected, you can select
which ones to analyze in lieu of processing the entire waveform. These controls are found on the Config tab.
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Operating Basics Selecting the Pulse/Packet

Config tab

In the Pulse Selection pane, click one of the available selections.

1st: Analyze first pulse only

2nd: Analyze second pulse only

3rd: Analyze third pulse only

4th: Analyze fourth pulse only

ALL: Analyze all pulses in succession (100 max)

OFF: Analyze entire waveform (no pulse detection)

The default selection is "OFF" for Spectral Analysis and "1st" for WiMedia Analysis.
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Operating Basics Setting the Resolution Bandwidth

NOTE. When performing WiMedia analysis, the pulses are referred to as "packets".

NOTE. For finer control over the portion of data used during analysis, you can also utilize the instrument
cursors in Tektronix oscilloscope. In the Tektronix oscilloscope display, place the cursors around the part
of the waveform desired and then recapture the data with Tek UWB.

Setting the Resolution Bandwidth
When performing Spectral Analysis, the resolution bandwidth used for the power spectral density and
spectrogram plots is user-definable. This control is found on the Config tab.

Config tab

Enter a desired resolution bandwidth in the following field:

The default selection is 5 MHz.

NOTE. This control is not available when performing WiMedia analysis. During WiMedia analysis, the
resolution bandwidth is always fixed at 5 MHz for PSD plots, and 50 MHz for Spectrogram plots.
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Operating Basics Setting the Center Frequency

Setting the Center Frequency
When using the Downconversion option, you will want to specify a center frequency for the analysis.
This control is found on the Config tab.

Config tab

Enter a desired center frequency in the following field:

The default selection is 2000 MHz.

NOTE. This control is available only when the analysis type is Spectral + Downconversion.
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Operating Basics Setting the Span

Setting the Span
When using the Downconversion option, you will want to specify a frequency span for the analysis.
This control is found on the Config tab.

Config tab

Enter a desired frequency span in the following field:

The default selection is 1000 MHz.

NOTE. This control is available only when the analysis type is Spectral + Downconversion.
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Operating Basics Saving the Downconverted Data

Saving the Downconverted Data
After setting an appropriate center frequency and span, downconversion of the acquired data may be
performed. These controls are found on the Config tab.

Config tab

Click in the Spectral Analysis + Downconversion Settings pane.
You can save the data in either .iqt or .mat format.

The .iqt file is a binary format compatible with the Tektronix RSA Vu software.

The .mat file is a binary format used by MATLAB..

The data in the files is the downconverted IQ data generated according to the values specified for the
center frequency and span.

NOTE. This control is only available when the analysis type is Spectral + Downconversion.
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Operating Basics Setting the Band Group

Setting the Band Group
Six WiMedia band groups fill the Ultra Wideband spectrum from 3.1 GHz to 10.6 GHz.

To set the band group to perform the analysis, click the Config tab.

Config tab

NOTE. The Band Group control is available only when performing WiMedia analysis.

In the WiMedia Analysis Settings pane, select one of the available selections from the Band Group list.

The default selection is 1.
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Operating Basics Setting the Time Frequency Codes

Setting the Time Frequency Codes
To set the Time Frequency Codes to perform the analysis, click the Config tab.

NOTE. Manual selection of TFC is necessary only if problems are encountered in demodulation.

Config tab

NOTE. The TFC control is available only when performing WiMedia analysis.

In the WiMedia Analysis Settings pane, select one of the available selections from the TFC list.

The default selection is Auto.
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Operating Basics Setting the Data Rate

Setting the Data Rate
To set the Data Rate to perform the analysis, click the Config tab.

NOTE. Manual selection of Data Rate is necessary only if problems are encountered in demodulation.

Config tab

NOTE. The Data Rate control is available only when performing the WiMedia analysis.

In the WiMedia Analysis Settings pane, select one of the available selections from the Data Rate list.

The default selection is Auto.
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Operating Basics Setting the Preamble Type

Setting the Preamble Type
WiMedia radios are required to support both standard and burst preamble length. A standard preamble
has 24 symbols and a burst preamble has 12 symbols. Normally the preamble type is read automatically
from the transmitted signal.

To set the preamble type to perform the analysis, click the Config tab.

Config tab

In the WiMedia Analysis Settings pane, select one of the available selections from the Preamble list.

The default is Standard (24).

24 Tek UWB Spectral Analysis Printed Help Document



Operating Basics Setting the Payload Length

Setting the Payload Length
To set the payload length to perform the analysis, click the Config tab.

Config tab

In the WiMedia Analysis Settings pane, select one of the available selections from the Payload Analysis list.

The default is 96 symbols which limits the analysis to the first 96 symbols.
Analyzing the Waveform

Analyzing the Waveform
Click Single or Run in the software to perform an analysis. The analysis depends on the state of the source.
Select a control in the configuration as follows:
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Operating Basics Analyzing the Waveform

Option Live channel Reference channel File
For live channel and
reference channel options

For File Option

The software acquires
and analyzes the selected
channel.

The software acquires
and analyzes the selected
reference channel.

The software acquires
and analyzes the selected
channel, reference, or file.
If one file is selected, the
behavior is the same as the
reference waveform input.
If multiple files (for example
three waveforms) are
selected, and you click
Test File, the first waveform
is loaded and analyzed
(shows File 1 of 3 in the
WFM File pane) and then
the second waveform is
loaded.
When you click the Test
File again, the second
waveform is loaded and
analyzed (shows File 2 of 3
in the WFM File pane) and
then the third waveform is
loaded.
When you click the Test File
again, the third waveform
is loaded and analyzed
(shows File 3 of 3 in the
WFM File pane) and then
the first waveform is loaded.

For live channel and
reference channel options

For File Option

more information

The software sequentially
acquires and analyzes
the selected channel and
logs results in the results
window.

The software sequentially
acquires and analyzes the
selected reference and
logs results in the results
window.

The software acquires and
analyzes all the selected
files from the source
directory. The software
logs the results in the
results window and stops.

xxx

To run a full analysis on an already acquired waveform, click . This is useful when you
want to change the analysis settings.

To stop all the software activity immediately and regain control, click .
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Operating Basics Voltage Versus Time

To clear all data from the Results window, click the button .
Viewing Plots

Voltage Versus Time
To control the visibility of the Voltage versus Time plot, click the Plots tab.

Plots tab

In the Voltage-vs-Time Display pane, click the On/Off button. From the pane, you can also select the
display style for the data, as well as the intensity for the shaded style.

Voltage-vs-Time Display pane

NOTE. The shaded style is effective only when capturing integer data types, such as those obtained from
live CH inputs (or unprocessed REF and WFM files). Waveforms which have been processed using
oscilloscope MATH are often converted to float and therefore do not allow shaded styling.
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Operating Basics Spectrogram

The following diagram shows a Voltage-vs-Time plot:

If the styling is set to shaded, the voltage versus time data is displayed as a temperature graded display
similar to WfmDB mode in the oscilloscope. Cursors are used within the plot to highlight the packet
that is being analyzed.

Spectrogram
To control the visibility of the Spectrogram plot, click the Plots tab.

Plots tab

28 Tek UWB Spectral Analysis Printed Help Document



Operating Basics Spectrogram

In the Spectrogram Display pane, click the On/Off button. From the pane, you can also select the default
frequency and time spans of the plot.

Spectrogram Display pane

NOTE. The Frequency Span and Time Span options are available only when performing the WiMedia
analysis.

The following diagram shows a Spectrogram plot:
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Operating Basics Power Spectral Density

Power Spectral Density
To control the visibility of the Power Spectral Density plot, click the Plots tab.

Plots tab

In the Power Spectral Density Display pane, click the On/Off button. From the pane, you can also select
the default frequency span of the plot.

Power Spectral Density Display pane

NOTE. The Frequency Span option is available only when performing the WiMedia analysis.
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Operating Basics Constellation

The following diagram shows a Power Spectral Density plot:

The legend displays the following when doing WiMedia analysis:

1. Spectral Mask with Pass/Fail status

2. Two ACPR Measurements with Pass/Fail status in each band

3. Power Spectral Density Measurements in each band

Constellation
NOTE. The Constellation Display is available when performing the WiMedia analysis.

To control the visibility of the Constellation plot, click the Plots tab.

Plots tab
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Operating Basics Constellation

In the Modulation Display pane, click the On/Off button for Constellation.

Modulation Display pane

The following diagram shows a Constellation plot:

The legend displays the following information:

1. EVM of the packet being analyzed in dB and %

2. Pass/Fail limits on EVM according to the WiMedia PHY test spec
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Operating Basics EVM Versus Symbol

EVM Versus Symbol
NOTE. This option is available when performing the WiMedia analysis.

To control the visibility of the plot, click the Plots tab.

Plots tab

In the Modulation Display pane, click the On/Off button for EVM-vs-Symbol.

Modulation Display pane

The software will adjust the visibility of the EVM-vs-Symbol plot accordingly. The traces are color coded
by band so that EVM differences between bands are observed more easily.
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Operating Basics EVM Versus Subcarrier

EVM Versus Subcarrier
NOTE. This option is available when performing the WiMedia analysis.

To control the visibility of the plot, click the Plots tab.

Plots tab

In the Modulation Display pane, click the On/Off button for EVM-vs-Subcarrier.

Modulation Display pane

The software will adjust the visibility of the EVM-vs-Subcarrier plot accordingly. The traces are color
coded by band so that EVM differences between bands are more easily observed.
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Operating Basics Using Plot Cursors

Using Plot Cursors
Whenever the mouse cursor is placed over either the Voltage vs. Time display or the Spectrogram display,
the cursor’s position in time is indicated with a time marker (bright line) in both displays simultaneously.
The time marker dynamically tracks the mouse position, showing that the two plots correspond. For
the Spectral Only and Spectral + Downconversion analysis modes, the Power Spectral Density (PSD)
corresponding to the current marker position is also dynamically updated in the PSD display, in orange.

The time marker automatically disappears when the cursor is no longer over the Voltage vs. Time or
Spectrogram display.
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Operating Basics Using Plot Zoom

Using Plot Zoom
Within each plot window, you can define a zoom box using the mouse or oscilloscope touch screen.
To zoom in, click and drag to select a zoom area. The plot displays the signal in greater detail and a
magnifying glass icon appears in the top right corner to signify that the plot has been zoomed. Single-click
without dragging or single-click on the magnifying glass to return to the previous view. Double-click to
return to full view. The zoom box is shown in white on the left side of the following image:
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Operating Basics Listing Window Data

Viewing Modulation Results History

Listing Window Data
To view the results, click the Reports tab.

Reports tab

In the Results History - WiMedia pane, the results are displayed.

The software provides a listing of the time and date of the test, the source (channel, reference, math, or
file) analyzed, the band group of the RF signal analyzed, the Time Frequency Code of the signal, cross
correlation, frequency offset, and measurement results including the Pass/Fail Status.

Saving the Results in .csv Format
To save or export results, click the Reports tab.

Reports tab

In the Results History - WiMedia pane, click .

The results are in .csv format so that they can easily be imported into the Microsoft Access database used
by the WiMedia PHY group at the compliance workshop.
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Operating Basics Generating and Saving Reports

Generating and Saving Reports
To generate a report after running the analysis, click the Reports tab.

Reports tab

In the Report Generation pane, select the appropriate options to control the format of the report.

The software provides the option to include or exclude the plot summary and the individual plot images. It
also provides the option to view the report in a browser window as soon as it is generated.

To create and save the report, click the button .

You can save the generated reports of the measurements in either .htm or .mht format. The .mht format,
also known as html archive format, saves all the text and image data in a single file. This is recommended
for convenience and data integrity.
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Operating Basics Clearing All the Results

The software provides the details of the configuration, measurement summary, modulation results from
each analysis, plot summary, and the supported individual plot images for the selected analysis type
in the report file.

Clearing All the Results

To clear all data from the results window, click the button .
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Operating Basics Clearing All the Results
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Tutorial Capturing Live WiMedia RF

Tutorial

Capturing Live WiMedia RF
NOTE. The oscilloscope must be set to 20 GS/s or greater for live capture of WiMedia RF.

Generating the RF Signal

Equipment required. DPO/DSA70804 or greater, keyboard and mouse, AWG7102 with option 6 (20 GS /s)
or WiMediaUWB radio, SMA cable, and Tekconnect SMA.

Load UWB waveform. UWB waveforms captured on the TDS6154C for playback on AWG7102 with
option 6 are available at www.tektronix.com.

1. Search using the keyword WiMedia.

2. Select AWG7102 WiMedia Radio Waveforms.

3. Load the file onto the AWG7102.

4. Open UWB WiMedia.awg on the AWG7102.

5. Press Run on the AWG7102.

6. Press the Ch1 On button and interleave “On”. Be sure the timing tab shows 20 GS/s on the AWG7102.

7. Connect Ch1 on the AWG7102 to Ch1 on the DPO70000 using an SMA cable or connect the antenna
of the Tek UWB radio to Ch1 of the DPO70000 with an SMA cable.

Capturing a Live RF Signal

Launch Tek UWB.

1. Select Ultra-Wideband Spectral Analysis in the DPO/DSA70000 Analyze menu.

2. Press the TekScope icon on the Ultra Wideband display to return to the oscilloscope display.

Set up the DPO70804 to Capture the UWB Waveform.

1. Set the vertical sensitivity to capture the RF waveform at about 90% of full scale. Usually this requires
setting variable gain in the DPO70000 vertical setup. In the following figure, it is set to 50 mV/div.

2. In the display menu, set the temperature color grading of the record view palette to see the information
in this complex RF waveform.

The packets are captured here at 25 GS/s, 10 μs/div, and 2.5 Mpts. The packet length in this example is
about 40 μs.
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Tutorial Capturing Live WiMedia RF

Set Trigger Holdoff for a Stable Display with Continuous Transmission. If the radio or AWG7102 is in a
mode to transmit continuously with default trigger holdoff by time, the display will be unstable. In this
example, since the packet length is about 45 μs, setting trigger holdoff by time to about 50 μs, a little
longer than the packet length, gives a stable display on the continuous RF waveform. If the packet length
is varying from packet to packet, use single sequence or set up Pinpoint trigger to capture a specific
packet length.

Or use Single sequence trigger. Real Time measurements are made from a single acquisition. A single
shot, Single sequence, acquisition does not require trigger holdoff by time to be increased.

Adjust the Trigger Position. Adjust the trigger position so that the acquired record starts with a full packet.
If the record starts in the middle of a packet, the software will have to search through the data in the
packet with a correlation function to find the beginning of the header. By triggering on the beginning of
a packet, analysis time is decreased.

Use Restore Application to go to Tek UWB. The application defaults to Ch1, Band Group 1, and analyzes
the first captured packet. If you want to analyze another or all captured packets, change the selection.

Application Defaults

To capture a waveform, click Single. Click Run and the last waveform acquired will be processed
continuously.

The results of the analysis are in the results menu and may be saved and exported.
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